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O erutayuvtec oto CERN: avarnapayouv o€ XWPO

TNV popdn mou €LXe N VAN eval SLOEKATOLLLUPLOCTO TOU Sec
LeTa To Big Bang-oL aviyveuteg tnv pwtoypadlouvv!
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CMS Experiment at the LHC, CERN
Data recorded: 2015-Jun-03 08:48:32.279552 GMT

Run / Event / LS: 246908 / 77874559 / 86
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OLQVLXVEUTEG-KAUEPESG
*ELval ol « LNXOLVEGY TIOU pnotp.onmouus yla va Bpoupe Vlt 0
KOOMOG HOLG ELVOLL ETOL.

* Mot ta cwpatidia exouv dradopetikec polec

* TL €0l N GKOTELVN UAN GTO GUMTTAV
* Eav Loxuouv ot dtadopeg BewplLeC OV AITOTMELPWVTOL VAL

ocuunAnpwoouv/avtikataotnoouv to “standard model”

* Mw¢ NTaV N Kowtn, MUKV mpwtn popdn tn¢ VANG KAoopoto Tou
deutepoAentou peta tnv MeyaAn Ekpnén

§ * Eav oL Bewpleg evomonceLg propouv va enainbeutouv
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Ol AVLXVEVUTEC-KOMEPEC ELVOLLKOTIWE ETOL...




 Buaviyveuteg-kapepeg Tpo).(Lprdd)oc;f .




- wt —— '
Ry | V. . Il . \
| | IR 1). ] [
1
. ~ {poemm fo ] £
| EEE)
et = ’ J
¢y 1 : [
oo -1
- - 4 §oe
1
] i ¥ ¥ | .
o s ‘ l
x5 | e
= i »jl- |
" -
-~
- : { J l
ol = 1 |
e . |
vt S o . | S .
] I R d |
St + -.,.E
110 U
DO 0

-

a0

30 Lago

CMS Experiment at LHC, CERN
'Data Recorded: Sat Apr 24 08:31:20 2010 CEST
| Lumi section: 795

Run / Event : 133874 / 64064942
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% Ouaviyveuteg-Bolopot pHloviwy

3D view,

CMS Experiment at LHC, CERN
Data recorded: Fri Sep 24 02:29:58 2010 CEST
Run/Event: 146511 / 504867308




% Ouaviyveuteg-Bakapiol poviwy

CMS CMS Experiment at the LHC, CERN
Data recorded: 2015-Oct-30 19:23:54.631552 GMT
Ru 260424 / 211873064 / 115




Ot cuyyxpovol peyadot aviyveuteg oto CERN: pwtoypadilouv

LE LEYAAN XPOVO-XWPLKN aKPLBELO TNV CUMTEPLPOPA TNG UANG
OTLC OUVONKEC apeowc peta To Big Bang (“apeowc “ <102 sec)

* OLQVLYVEUTEC ELVOL TIPOYLLOTLKOL LEYOAOL....

Ovopa Bapog (tn) | Meyebog (z,r) | ApXiko kooto¢ | AvBpwroL
(MCHF)

ALICE 10000 26,16 ~300 ~1500

ATLAS 7000 44,22 ~550 ~3000

CMS 13000 21,16 ~550 ~3700

LHCb 4500 20, 5+ ~300 ~800

...ylatL penel va «pwtoypadloouv» TTOAU « LKPOL» oVTIKELpHEVA (< 10716 sec),
MLAOLLLE YLOL OLITOCTOLOELG HLKPOKRETPOU Kol Xpovoug {wng ppaypoto Tou psec.

OL {ntoupevec dwrtoypadLec ewval tou pnoloviov Higgs, UMEPCGUUUETPLKWV
ocwHaTLOLWVY, mini powpeg TPUNEC, Baputovia n aAleg popdeg tng VARG (quark —
gluon plasma...)
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CMS ~13000 t

EM KaA
Yrepaywylo cwAnvoerdeg OPLUETPO

ECAL
Scintillating Adpoviko Kaloplpetp

PbWO4 crystals Plastic scintillator/brass
sandwich

«Zuyog» cdnpeu

15m

Tpo)toypadioc

Silicon Microstrips
Pixels

Total weight : 13,000 t ..
Overall diameter : 15 m
Overall length : 21.6 m
Magnetic field : 4(3.8) Tesla

OaAQNOL HLOVIWV

Drift Tube Resistive Plate Cathode Strip Chambers and
Chambers Chambers Resistive Plate Chambers
22 m



OL 4 «peyalow» aviyveutec tou LHC:

Exouv oloL ta LdLa tepLtou Koppatia (UTTAVIXVEUTEG). ...

Ymavixveuing ALICE ATLAS CMS LHCb
Vertex v V \4 V
detector/Tracker

KaAopluetpo V v v v
Muon detector |V \4 v v
Awadopa L \4 v NRRNNY

OMoL gxouv evav kataypadea tpoxtwyv (Tracker ota EAAnvika!) yia vat «BAemouvy tnv
Stadpoun Twv GoPTIOUEVWV CWHATIOLWY OTO XWPO

OAoL exouv eva KahopLletpo (HAekTpopayvnTLko Kot ASpoVLKO) yla Vol LETPOUV TNV
EVEPYELQ

OAOL £XOUV QVIXVEUTEC HLOVIWV-YLOTL TA povia 6ev «meBatvouv» otol KAOAOPLUETPO KOl
N AVLXVELUON TOUG ELVAL TIOAU ONUOVTLKN
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ATLAS

~7'000 t

Muon Detectors Electromagnetic Calorimeters

. Forward Calorimeters
Solenoid
[
- End Cap Toroid
= | e =

J
Barrel Toroid Inner Detector Shielding

Hadronic Calorimeters

44 m

22m
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Mo «peto»y tov CMS
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H ENIAOTH KAI KATATPA®H TQN “rETONOTQN”

ATLAS
OL aviXveUTEG ewval axpnota akpBa rayvidia AL AS TDAG Global Architecture
XWPLG TO CUOTNUA ETUAOYNG YEYOVOTWY _— — —
(trigger) kaw tTnVv emthoyn Kat kotaypadn e
bdebopevwv (DAQ). Edw ta MHz kaw ta PB ewvat [ ]

KaOnuepwvotnta ya ta rteputov 100
ekatoppupla “kavaiia” mou “Stapalouv” Tig
TIANPOPOPLEG TIOU TIPOEPXOVTOL ATTO TLG
OUYKPOUGELG L]

| Eventbuilding |

CMS o
O
o
40 MHz Level 1 H Detector Front-Ends
Trigger T T T
¢ —'—H Readout
| - jl]‘r ;II]TFS
Event ) Control
5 Builder Network 100 GB/s and
L Menagn M Monitor z
< I I I l I Filter
_I_"—|_ Systems
2
10° Hz Computing Services




AMa kat (prawvw oto Ogpa...):

Lo TOV aVLYVEUTN ...

*2uotnpata HAektpkng tpododociac (~15-20kA, LOXUG, CUVEXEC Kol EVAAQGOOEVO)
eZuotnpata aeplwv (evdAekta Kat pun )

*Juotnpata Puktkwv( ~ -30°C kataypadeac TpoxLwy)

eTuotnpata eEunvwyv povwtwyv( ~ -20°C kataypadeag tpoxtwv ~ +17°C ECAL)
°ZUOTNUATO EAEYXOU KLVIOEWV OVTLKELLEVWV (UTIOOVLXVEUTEG Kol OANQL KOJLOTLOL
“Tuylouv” 2 kai 3 Tovwoug, aaOntnPeg)

euotnuata eheyyou nmepiBaiiovroc (Eepoc aepac, alwto)

oyuotnuata evbuypapionc (laser) kat eAeyxouv kwvnoswv (CCD kapepec)
*ZUOTNATA LETPNOEWC Kal oXtL Hovo, Tn¢ padievepyelag (dtadopetikec pebodol)

Mo o tepLBAAAOV YUPW OUTTO TOV AVIXVEUTN

*ZUOTNHATA OEPLOMOU TOU TIELPOMATLKOU Xwpou (+/- 2°C)
*Zuotnpata eAeyxou nepiBaiiovrog (Vypaotia, Oeppokpacia)
eJuotnpata PukTtkwv (~ 159C)

*Zuotnpata eubuypapiong (laser)

*ZUOTNUATA KLVNONG TWV KOMUATLWY Tou avixveutn (ouvoAwka 13!)

la tov Mayvntn

eZuoTtnpata eAeyxou nepBailovtog
eJuotnpata PUKTkwv(-268°K)

*Zuotnpata Kevou (povwan)

*2uotnpata HAektpkng tpododociac (18-20kA)




* 0O oxeblaopoc, mpooopowwon, kataokeun, enBefawwon, Babuovopnon €vog aviyveutn
LLE aKPLBELA LETPNONG EVEPYELEC KOl LKAVOTNTA KaTaypadng TOANATTAWY YEYOVOTWV...

Tou tumou LHC dev ewal eva emixelpnpa «dpuotkne» (Lovo)-ewval EMLXELPNUO LNXOVLIKNG,
NAEKTPOVIKWV Kol NAEKTPLKWV OXESLOOUWY, UALKWV (OTEPEQ KATAOTAON), UTTOAOYLOTIKWVY
PoypappatTwy, oxedlaopuou epodlacuwyv Kol opyavwaong SLolknong, KATaoKeEUNG Kal
opyavwong epyotaélou KTA.

* H «Aettoupyla» (run) tou avixveutn xpelaletal MOAU ELOLIKEUEVO TIPOCWTILKO yLa VOl
LTTOPECEL VAL ELVaL AettoupyLkog kot va avaBaBpuiletatl yua 20-30 xpovia. To ap)Lko
TPOOWTILKO Ba avavewBeL, LoLaLtepa yLaTL SEV UTTAPXOUV «LOVIUEG» BECELC.

* O aviyveutng OmwG KOL O ETILTAXUVTNG EXEL TTOAU LEYAAUTEPN CUMUETOXN QTTO TO TIPOCWTILKO
tou CERN, xwptc BePfata va amokAeLlovtol TOAAEC CUVEPYAOLEG.
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Login/Logout

3rd Quarter ath Quz

Jun

Jul | Aug [ Sep | Oct |

Task Name - |Duration
260 |~ Perform work on YB0+Z with Full acces to vacTank 33.5 days
261 Open YB+2 / YB+1 1.5 days
262 Remove MABs 1day
263 Install access staircase to inside of VacTank 1day
264 Remove CCM jumpers (RBXs) inside VacTank 18 days
265 Remove thermal shield for TK 7 days
266 Install additional services under thermal shield Sdays
267 Install temperature sensors for TK 2 days
268 Perform TK cold test 9days
269 Refurbish Quick connectors 18 days
270 = HO-DT-RPC tasks 20 days
271 = Remove ECAL LV cables 8 days
272 S02M 1day
273 S03 N 1day
274 S06 F 1day
275 S07F 1day
276 511 2 days
277 510 2 days
278 = Remove DT-RPC cables 7 days
279 502503 1day
230 506 507 1day
281 511 1day
282 510 1day
283 = Perform work on HO 10 days
284 502 1lday
285 503 1day
286 506 1day
287 507 1day
288 s10 1day
289 511 1lday
290 = DT chamber extraction for HV repairs 9 days

09/08 T 26/09
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°ZUGCTNHOTO EAEYXOU KLVNOCEWV OVTLKELLEVWV (UTTOOVLXVEUTEG Kal AACL KOpLaTLL
“Tuylouv” pexpL 2 Tovvoug, atodntnpeg)

Ta Bopn TWV KORUOTLWV HITOPOUV VAL

ayyLEouV TouG 2 TOVOUG KaL KLVOUVTaLL

ne vdpavAka cuotnuata. OAa avta

QLUTOJLOLTOL KOIL QUTTO JLOLKPLAL... [LOL TO

~—  mpoBAnua tou va Bpebouv n va

’ avarttuxBouv awedntnpeg kataAAnAol
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euotnuata eleyyou mepBallovroc (Eepoc aepac, alwto, Beppokpacior)

Kootog¢ ~150,000 svpw
Mpootacia Tou avViXVEUTN TPOXLWV arto tpoBAnua
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We would like to work with you on possible projects that will teach
programming to students, (scratch https://scratch.mit.edu/) in the
context of learning to measure and control numbers; programming
Provided it is done in a way accessible to their age teaches them
the logic and the discipline of going about a measurement

Scratch is used for programming games, playing with photos,
putting together music, etc. | am sure that in this context some of
You might have even used it

We would like to deal with the “Scratch for Arduino-S4A”

version because it gives you the option of combining simple and
visual oriented programming with the Arduino platform that makes electronics
easy and students can make things happen.



https://scratch.mit.edu/

All information about the Arduino platform can be accessed at
https://www.arduino.cc/

From this page you can download the appropriate software, be it
Windows, Linux or Mac OS X (Mac OSX Lion or later). You will not deal
With this software as you will not be an Arduino developer.

However, using the Arduino software you will tell your system WHAT
Arduino Platform you are using:...you could start Arduino, go to the
menu, select Tools and from there select Boards and click on the
board type you have connected (Uno, Mega, nano, etc)...

Then, to be sure that you are connected to the board, try to run a
program called “Blink” that makes an LED already built on your
Arduino to “blink” by going to “Menu”, “File”, “Examples”, “Basics”,
“Blink”..


https://www.arduino.cc/

Sketch Tools Help

S4AFirmwared &

7/ MEW IN VERSION l.6c (by Jorge Gomez):
// Fixed variable type in pin structure: pin.state should be int, not hyte
// Optinized speed of execution while receiving data from computer in readSerialPorti(

EERE USRI 6 Blink | Arduino 1.6.11 o (=]
/7 hdded new struc

Fie Edit Sketch | Tooks Help
P This naes

Y7 - Allews to o] Auta Format T

/¢ - Eliminates t Archive Sketch a[pin-4])

/4 - By using an Fix Encoding & Reload el e

/4 Changed all fun Serial Manikor Carl#shift+ ~|FislPort(), wpdateAcruator() and sendUpdatedctuator(]
/¢ Fixed possible Serial Plotter Cirlshift-L ged Eor delagMicroseconds()

/4 Some minor cadi
WiFi101 Firmware Updater

/7 MEW IN VERSION
// Fixed compatibi
/¢ readSerialPort(

Boards Manager .

3 ¥ Ardiino AR Boards

7/ - created sted Port: "COM7 Y Arduino Van
7/ - updatehctuar Get Board Info T rollie Se I ect boa rd t e
7/ Memory use opti i e ) Arduing Duemlanove o Diecimia y p
7/ Cleaning soue p @ Ardiino Hano
Burn Bootloader
/7 Awoid using som 4 Mega ar Mega 2560

Arduino Mega ADK
Arduing Leonardo
Arduino/Genuing Micro
Arduing Esplara

7/ MEW IH VERSION
// Refactored rese
// Merged code for
7/ Merged patch £o

4/ the setup function runs once when you press Arduine Mini
d 1=
¢/ WD TH vERsTaw | COLY TR0 Lo Arduino Ethernet
/7 initialize digital pin 13 as an output.
/4 Thanged pin 6 £ 4] Arduino Fio
Arduino BT

/4 MEW TH VERSTON
J/ Changed Serial.

LilyPad Arduino USE
LilyPad Arduino
Arduino Pro or Pro Vi

fible with latest Arduino IDE (1.0}

/7 MEW IN VERSION
/4 Mow it works on
7/ timerz set to 2
#/ readierialport|
7/ pulsei) wodifie JUTY, Arduing Gemma
J/ updateServallators changes 1Ts name as a global variable had Che Sale hame.

/¢ Some minor fixes.

Arduino MG or older
Arduino Robat Control
Arduino Robat Motor

rypedef emm {
input, SErvOmOtOr, pum, digital }

pinType;
typedsf sTruct pin {
pinType type; /#Type of pin
int state; //%tate of an output
sibyte value: /fValue of an imput. Not used by now. TODQ
1:
pin arduinePins[14]: //hrray of struct holding 0-13 pins informacion '_|
>

Arduina Nano, ATme,

i Lepupdt - .. | B husemann.. | ] 2016-082... | € s4aFimow... [&D Blink | Ar... P GCELAEES - »@RIBF Eh sem

tart| © @ (2 GreskTea... | (2 Arduino- matthieur... | | photos oo | B Presentati.. | [ Elineskath.. | &) skype™[... |




&8 Blink | Arduine 1.6.11 [ ==l %
EN

File | Edt Sketch Tooks Help

Blink

0

// the setup function runs once when you press reset or power the board

link program, you can
play by changing the
millisecond numbers

vold setup() {
// initialize digital pin 13 as an output.
pinMode (13, OUTEUT):

ain forever

// the loop function runs over

void loopf() {
digitalWrife
delay (10
digitalWrit,
delay (1000

on (HIGH is the wvoltage level)
ait for a second
// turn the LED off by making the wvoltage LOW
// walt for a second

stat| € @ O GreskTe. |2 ardino-.| | matthieu photos . Sereensh, 3] welcore.... | G resenta... | G Elineskat... | &) Skype™ .. | i Lep.paf -.. | Bl usemen... | =] 2me-te-...| €D saafim... [Boink 1. | 90 TA RED = © U » ® O B[ iy 156 m




Now you can proceed and download the Scratch environment from
https://www.arduino.cc/

From this page you can download the appropriate software, be it
Windows, Linux or Mac OS X (Mac OSX Lion or later). You will not deal
With this software as you will not be an Arduino developer.

However, using the Arduino software you will tell your system WHAT
Arduino Platform you are using:...you could start Arduino, go to the
menu, select Tools and from there select Boards and click on the
board type you have connected (Uno, Mega, nano, etc)...

Then, to be sure that you are connected to the board, try to run a
program called “Blink” that makes an LED already built on your
»n «u ” «u

Arduino to “blink” by going to “Menu”, “File”, “Examples”, “Basics”,
“Blink”..


https://www.arduino.cc/

All information about the Arduino platform can be accessed at
http://s4a.cat/

From this page (Downloads)you can download the appropriate

software, be it for Windows, Linux or Mac OS X (Mac OSX Lion or later).
Make sure that you also get the program that you have to execute in
order to “tell” your Arduino platform that it has to work with Scratch; the
program is found in

“Installing the Firmware into your Arduino”, right-click on “here” and
save target as a .ino and NOT a .htm file as proposed in your

Documents -> Arduino and then run it!


http://s4a.cat/
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Download and Install

1

Install sur
Download

firmware
into your
Arduino

Enjoy
programming
your world!

and install
S4A

Installing S4A requires you to install software both in your PC and your Arduino
board. Here you'll find the detailed steps to get it up and running.

Installing S4A into your computer

S4A works in the three major consumer operating systems. Download and install
the one that fits your configuration:

+ Windows

- Mac

+ Linux (Debian)

« Linux (Fedora) (version 1.5)

+ Raspbian (Debian for RaspberryPi) (version 1.5)

Installing the Firmware into your Arduino

This firmware is a piece of software you need to install into your Arduino board to
be able to communicate with it from S4A

Download and install the Arduino envirenment by following the instructions.
on http://arduino.cc/en/Main/Software. Take in account Arduino Uno requires
at least version 0022

Download our firmware from here

Connect your Arduino board to a USB port in your computer

Open the firmware file (S4AFirmware16.ino) from the Arduino environment
In the Tools menu, select the board version and the serial port where the
board is connected

Load the firmware into your board through File > Upload

Arduino drivers
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Installing the Firmware into your Arduino
This firmware is a piece of software you need to install into your Arduino board to
be able to communicate with it from S4A
« Download and install the Arduino environment by following the instructions.
on http://arduino.cc/en/Main/Software. Take in account Arduino Uno requires
at least version 0022
+ Download our firmware from here ~
= Connect your Arduino board to a USB port in your computer :
« Open the firmware file (S4AFirmware16.ino) from the Arduino environment
= In the Tools menu, select the board version and the serial port where the
board is connected
« Load the firmware into your board through File > Upload
Arduino drivers . .
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When you first “read” the Arduino via Scratch, this is what it looks like:
Values that “change”
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There are many types and models of Arduino.

We will be trying to concentrate using the nano Arduino and Uno
which we will use for all the projects we propose to you. Using the
Arduino in the Scratch environment you can read “analog”

sensors and digital “sensors”.

Sensors are a huge industrial/scientific

explosion of our times and CERN is a remarcable sensor
consumer/producer.

Sensors provide information about everything and can be read in an
analog way like current, voltage, resistance and many others (favour
these for learning) or they can be digital and have an integrated
microprocessor that gives you directly the numerical measured
value.



The analog sensors you can read in Scratch are attached to your
Arduino platform (literally)

* Thermometers

* Light level (photo resistors)

* Humidity

* Flow

* Pressure

* and many others ....

the numerical measured value.
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Failed to open MIDI output device Microsoft MIDI Mapper:
'There is no driver installed on your system.
Failed to open MIDI output device Microsoft MIDI Mapper:
'There is no driver installed on your system.
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The digital sensor connections ; powering and D3 as output
for a temperature sensor, DS18B20 (+125 to -55°C)
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Each sensor requires
two separate Arduino
Analog Inputs to be
read out (T - yellow
and RH - blue wires).
The Arduino Nano has
eight Analog Inputs, AO

In a cabled system, we
would need at least
two lines for powering
the sensors (VCC and
GND) plus two lines
per sensor for the two
analog outputs, better

yet four lines (analog

Kootoc ~30 evpw
output plus extra GND)

to A7, so we can read
four HS-2000 sensors
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Analog Output sensor
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